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ВВЕДЕНИЕ 

С изобретением цифровой фотографии в середине XX в. возникли 
предпосылки для появления и развития цифровой фотограмметрии. Пер-
вые цифровые фотограмметрические системы были разработаны в 80-х гг. 
прошлого века, они пришли на смену аналитическим фотограмметриче-
ским приборам, переняв математический аппарат аналитической фото-
грамметрии, лежащий в их основе.  

Возможности цифровой фотограмметрии в настоящее время в значи-
тельной мере расширились благодаря использованию новых алгоритмов 
автоматизированной обработки и увеличению производительности ком-
пьютерных вычислительных систем.  

В теоретической части настоящего учебно-методического пособия 
кратко изложены основы получения цифрового изображения, основные 
методы трансформирования цифровых снимков, полученных сканерными 
и кадровыми съемочными системами. Рассмотрены современные методы 
автоматизации поиска точек на цифровых снимках, методы слияния раз-
номасштабных мультиспектральных и панхроматических изображений. 
Практическая часть состоит из методических указаний к лабораторным 
работам в современных программных продуктах, в которых применяются 
методы, рассмотренные в теоретической части. 

Учебно-методическое пособие предназначено для обучающихся, 
изучающих дисциплину «Цифровая фотограмметрия», а также для широ-
кого круга бакалавров и магистрантов, занимающихся обработкой данных 
дистанционного зондирования. 
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1. ЦИФРОВОЕ ИЗОБРАЖЕНИЕ 

1.1. Способы получения цифрового изображения 

Растровое цифровое изображение представляет собой двумерную матри-
цу, элементами которой являются значения яркости. За начало системы ко-
ординат цифрового изображения принимается пиксель, расположенный  
в верхнем левом углу изображения. Цифровое изображение реального объ-
екта окружающего мира может быть получено путем сканирования аналого-
вого снимка или непосредственно путем съемки цифровой камерой. 

В цифровых съемочных системах для регистрации изображения ис-
пользуются электронные светочувствительные датчики – приборы с заря-
довой связью (ПЗС) или КМОП (англ. CMOS) – комплементарная струк-
тура «металл – оксид – полупроводник». В современных бытовых цифро-
вых камерах применяются КМОП-датчики, связано это с меньшим энер-
гопотреблением и дешевизной КМОП-матриц по сравнению с ПЗС. Счи-
тается, что ПЗС имеет большую надежность, более низкий уровень тепло-
вого шума, большую светочувствительность поэтому в аэро- и космиче-
ских съемочных системах до недавнего времени часто использовались 
матрицы именно этого типа [1–4]. В настоящее время благодаря развитию 
технологии КМОП такие матрицы начинают вытеснять ПЗС в профессио-
нальном аэросъемочном оборудовании [5].  

Коротко рассмотрим устройство прибора с зарядовой связью на при-
мере так называемой полнокадровой ПЗС-матрицы (с устройством работы 
других типов матриц можно ознакомиться в [6]) .  

ПЗС состоит из кремниевых детекторов, в которых под действием фото-
нов света возникают и накапливаются электроны. Электрический заряд, 
накопленный на светочувствительном элементе, прямо пропорционален 
энергии падающего на него света. Между рядами светочувствительных эле-
ментов расположены электроды переноса, при синхронной подаче потенци-
ала на которые происходит перетекание зарядов (зарядовая связь) к так 
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называемому последовательному регистру сдвига. Последовательный ре-
гистр сдвига – это устройство, подключенное к последней строке матрицы, 
представляющее собой строку ПЗС-элементов, заряды которой считываются 
поочередно (рис. 1). 
 

 

Рис. 1.  Принципиальная схема работы ПЗС 
 
 
Электроды переноса занимают значительную часть сенсора [7, 8], по-

этому для увеличения эффективной площади фотоприемника каждый дат-
чик матрицы может быть покрыт микролинзой (рис. 2). 

 

 

Рис. 2. Увеличенный фрагмент светочувствительной матрицы 
 
 
На выходе последовательного регистра сдвига при считывании заря-

дов ПЗС формируется аналоговый электрический сигнал. Для преобразо-
вания аналогового сигнала в цифровой формат в съемочных системах ис-
пользуется аналого-цифровой преобразователь (АЦП), при этом он может 
являться частью матрицы или реализован как отдельная микросхема.  
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Аналоговый сигнал представляет собой непрерывную функцию изме-
нения интенсивности по времени. При переводе в цифровую форму сиг-
нал, по временной шкале, с определенной частотой делится на дискретные 
значения. Этот процесс называется дискретизацией аналогового сигнала 
[9–13]. Процесс дискретизации схематически представлен на рис. 3. 

 

 

Рис. 3. Дискретизация 
 
 

Выбор частоты дискретизации зависит от максимальной частоты сиг-
нала. Согласно теореме Котельникова, исходный сигнал может быть вос-
становлен однозначно и без потерь по своим дискретным отсчетам, взя-
тым с частотой большей, чем удвоенная предельная частота спектра: 

 

 дискр пред2 ,    (1) 

 

где ωпред – предельная частота спектра. 
Вместе с дискретизацией при преобразовании аналогового сигнала  

в цифровой выполняется квантование [9–13] – это разбиение исходного 
диапазона на заданное число интервалов (рис. 4). 

 

 

Рис. 4. Квантование 
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Результат применения квантования и дискретизации к исходному 
аналоговому сигналу представлен на рис. 5. 
 

 

Рис. 5. Результат квантования и дискретизации исходной функции 

 

1.2. Форматы записи многоканальных данных  

Съемка современными системами дистанционного зондирования 
Земли как аэро-, так и космического базирования обычно выполняется  
в нескольких зонах электромагнитного спектра. При этом для каждого 
диапазона используется свой набор датчиков (сгруппированных в ли-
нейку или матрицу). Данные, полученные с разных сенсоров, должны 
быть соответствующим образом организованны для обеспечения их 
просмотра и обработки в программных продуктах. 

В дистанционном зондировании применяют следующие три основ-
ных способа организации данных в многоканальных изображениях: BIP 
(Band Interleaved by Pixel), BIL (Band Interleaved by Line), BSQ (Band 
Sequential). 

Формат BIP основан на попиксельной записи информации, при кото-
рой пиксели с одинаковым порядковым номером, но относящиеся к раз-
ным спектральным каналам съемки, записываются подряд. Последова-
тельность записи данных в формате BIP показана на рис. 6.  
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Рис. 6. Последовательность записи данных в формате BIP 
 
 
Формат BIP непригоден для большинства практических задач с боль-

шим объемом данных. Использование формата BIP не позволяет быстро 
отсортировать данные, относящиеся к определенному спектральному диа-
пазону, для которого формируется изображение.  

В формате BIL строки, соответствующие разным каналам съемки, но 
имеющие один и тот же порядковый номер, записываются последователь-
но. Этот формат обеспечивает компромисс между производительностью  
в пространственной и спектральной обработке. Пример размещения дан-
ных в формате BIL показан на рис. 7.  

 

 

Рис. 7. Последовательность записи данных в формате BIL 
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В формате BSQ сначала записываются все данные для первого канала, 
затем для второго, третьего и т. д. (рис. 8).  

 

 

Рис. 8. Последовательность записи данных в формате BSQ 
 
 
Формат BSQ широко применяется на практике, поскольку способ раз-

мещения данных ближе всего отвечает задачам их просмотра и анализа. 
Главным недостатком формата BSQ является то, что если необходимо вы-
полнить обработку не всего снимка, а лишь его части, то в любом случае 
необходимо считывать весь набор данных.  

Выбор оптимального формата зависит от условий поставленных задач. 
Если изучается вся сцена во всех спектральных диапазонах съемки, удоб-
нее использовать форматы BSQ и BIL. Если анализируется небольшой 
участок с известным местоположением, то в этой ситуации лучше исполь-
зовать формат BIP, поскольку для этого участка известны значения ярко-
стей во всех спектральных диапазонах [14]. 

1.3. Съемочные системы 

Космические съемочные системы. В настоящее время орбитальная 
группировка спутников состоит из большого количества аппаратов, при-
надлежащих различным странам. Эти съемочные системы различаются по 
способу формирования изображения, пространственному и радиометриче-
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скому разрешению, периодичности съемки одного и того же участка 
местности и другим параметрам. Подробнее с современными космиче-
скими системами можно ознакомиться в [15, 16]. 

Аэросъемочные системы. Независимо от технологии реализации сен-
сора (ПЗС или КМОП), цифровые фотограмметрические камеры по спо-
собу формирования кадра делятся на системы, использующие матричные 
датчики, и оптоэлектронные сканеры с линейками светочувствительных 
элементов. Принцип работы камер на основе матричного сенсора, распо-
ложенного в фокальной плоскости, такой же, как и у пленочных аэрофо-
тоаппаратов (кадр строится в единый момент времени, аэрофотосъемоч-
ный маршрут строится из перекрывающихся кадров). На рис. 9 показана 
схема получения снимка кадровой съемочной системой. 

 

 

Рис. 9. Формирование кадра кадровой съемочной системой 
 
 
КМОП-матрицы современных аэросъемочных камер достигают раз-

решения 25 728 × 14 592 (DMC III) [5]; сопоставимое или большее разре-
шение можно получить, увеличивая число матриц. Например, система  
UltraCam Eagle 4.1 [17] выполняет съемку четырьмя камерами с интерва-
лом 1 миллисекунда из единого центра фотографирования, формируя та-
ким образом на 9 КМОП-матриц снимок с разрешением 28 110 × 18 060. 

С характеристиками современных кадровых аэросъемочных камер 
можно ознакомиться в [18].  

Примером сканерных камер являются зарубежные модели Leica 
Geosystems ADS 80, ADS 100, а также российские камеры ЦТК-140  
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и ЦМК-70 [18]. Построение изображения этими камерами принципиально 
отличается от кадровых систем и аналогично процессу космической ска-
нерной съемки. При съемке сканерной съемочной системой изображение 
земной поверхности фокусируется на линейку светочувствительных эле-
ментов, расположенную в фокальной плоскости объектива. Линейка ори-
ентирована поперек направления движения носителя. Из последователь-
ных строк формируется кадр (снимок). Ширина снимка соответствует 
размеру линейки ПЗС, а длина зависит от количества строк, зафиксиро-
ванных в процессе съемочного сеанса (рис. 10).    

 

 

Рис. 10.  Формирование сканерного снимка 
 
 

Основное отличие сканерных снимков от кадровых – это отсутствие 
единого центра фотографирования и различие элементов внешнего ориен-
тирования для каждой строки снимка. 

Для получения элементов внешнего ориентирования каждой строки 
при выполнении аэросъемки, используются системы ГНСС и IMU (Inertial 
Measurement Unit). 
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2. ТРАНСФОРМИРОВАНИЕ И ОРТОТРАНСФОРМИРОВАНИЕ 
СНИМКОВ 

2.1. Цифровое трансформирование кадровых снимков 

При трансформировании выполняется преобразование снимка в за-

данную проекцию (центральную, ортогональную, картографическую); 

трансформированные снимки используются для построения фотопла-

нов.  

При трансформировании в том числе выполняется исправление ис-

кажений координат точек снимка, обусловленных влиянием угла 

наклона. Смещения точек снимка вызваны изменениями масштаба 

наклонного снимка, который совпадает с горизонтальным на линии ну-

левых искажений. Вычислить величину смещения точек снимка, вы-

званную его наклоном, можно по формуле  
 

 0

0

2 sinφsinαδ
sinφsinα

rr ,
f r

 
 

 (2) 

 

где  – угол между линией нулевых искажений и радиус-вектором; 

α0 – угол наклона снимка; 

r – радиус-вектор, расстояние от точки до точки нулевых искажений; 

f – фокусное расстояние. 

Соответствующие элементы центральной проекции изображены на 

рис. 11. 
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Рис. 11. Элементы центральной проекции 
 
 

Здесь S – центр проекции; 
о – главная точка снимка; 
p – картинная плоскость; 
n – точка надира; 
с – точка нулевых искажений; 

 – угол поворота снимка; 

vv – главная вертикаль; 
hchc – линия нулевых искажений. 

В «докомпьютерную» эпоху трансформирование аналоговых снимков 
выполнялось на специальных приборах – фототрансформаторах. В насто-
ящее время трансформирование цифровых снимков выполняется в специ-
ализированном программном обеспечении. 

Цифровое трансформирование снимков заключается в преобразова-
нии координат элементов матрицы исходного цифрового изображения та-
ким образом, чтобы положение элемента в матрице преобразованного 
изображения соответствовало трансформированным координатам. Транс-
формирование осуществляется по формулам [19–21]: 
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  (3) 

 

где f , y0 , x0– элементы внутреннего ориентирования снимка;  
c, b, a – направляющие косинусы углов α, ω, κ.  
После вычисления координат пикселей они округляются до целых 

значений, и соответствующим элементам Pxy
0 присваиваются значения яр-

костей элементов Pxy.  
Этот способ трансформирования называют «прямым цифровым 

трансформированием». 
На рис. 12 изображен принцип прямого трансформирования. 

 

 

Рис. 12.  Прямое цифровое трансформирование 
 
 

При прямом трансформировании возможны пропуски элементов (см. 
рис. 12), вызванные тем, что рассчитанные координаты элементов округ-
ляются до целочисленных значений. Пропуски пикселей возникают также 
по причине «растягивания» изображения в положительном направлении 
оси y от точки нулевых искажений.   

Для заполнения пропущенных элементов трансформированного изоб-
ражения выполняется интерполяция яркостей (метод ближайшего соседа, 
билинейная интерполяция, бикубическая интерполяция). 
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При обратном цифровом трансформировании создается пустой мас-

сив для записи трансформированного изображения. Для каждого 0
, i jP  эле-

мента массива по нижеприведенным формулам [19–21] выполняется рас-
чет координат элемента исходного нетрансформированного изображения, 
и элементу трансформированного изображения присваивается яркость 
элемента с рассчитанными координатами нетрансформированного изоб-
ражения: 
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 (4) 

 

Схема выполнения обратного цифрового трансформирования показа-
на на рис. 13. 
 

 

Рис. 13. Обратное цифровое трансформирование 
 
 

Из рис. 13. видно, что в случае использования обратного цифрового 
трансформирования не будет пропущенных элементов, так как выполня-
ется расчет координат на исходном изображении с использованием коор-
динат каждого элемента трансформированной матрицы.  
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2.2. Цифровое ортотрансформирование снимков 

Аэроснимок является изображением местности в центральной проек-
ции, а топографический план создается в ортогональной проекции. Изоб-
ражения в этих проекциях совпадают только в случае, если местность 
плоская и угол наклона α равен 0. Любые отклонения от плоскости приво-
дят к смещению положения точек вдоль вектора, направленного от точки 
надира снимка по законам центральной проекции. Смещения точек сним-
ка, вызванные рельефом местности, можно вычислить по формуле 

 

δ h
r h

r ,
H


                                                      (5)

 
 

где H – высота фотографирования; 
r – радиус-вектор, расстояние от точки до точки надира; 
h – высота точки местности. 
Процесс исправления искажений снимка, вызванных углами наклона 

снимка и рельефом местности, т. е. приведение снимка в ортогональную 
проекцию, называется ортотрансформированием. 

Для цифрового ортотрансформирования используется информация  
о рельефе, представленная в виде цифровой модели рельефа (ЦМР). 

При обратном цифровом ортотрансформировании для каждого эле-
мента пустого массива будущего ортотрансформированного изображения 
выполняется вычисление координат точек местности X, Y по формулам, 
при этом используется среднее значение Z из ЦМР: 
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  (6) 

 

Затем с использованием высотной отметки элемента матрицы высот 
(ЦМР) с рассчитанными координатами X, Y вычисляются новые коорди-
наты X, Y. После завершения вычисления X, Y, Z по формулам (3) вычис-
ляются координаты соответствующего элемента на нетрансформирован-
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ном изображении. Значение яркости элемента нетрансформированного 
изображения присваивается элементу пустого массива ортотрансформи-
рованного изображения [21]. Схема цифрового ортотрансформирования 
представлена на рис. 14. 
 

 

Рис. 14. Обратное цифровое ортотрансформирование 
 

2.3. Трансформирование космических снимков 

При космической съемке в начальный момент времени, соответству-
ющий первой строке изображения, и через определенные интервалы вре-
мени на протяжении формирования всего снимка выполняются навигаци-
онные и инерциальные измерения; в результате в память съемочной си-
стемы записывается набор линейных и угловых элементов внешнего ори-
ентирования. Время формирования строки изображения известно, поэтому 
элементы внешнего ориентирования рассчитываются с высокой точно-
стью для каждой строки и могут быть использованы при обработке сним-
ков с использованием строгой математической модели связи координат 
точек местности и сканерного снимка. 
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Кроме строгого математического способа фотограмметрической обра-
ботки космических снимков применяются и параметрические методы (по-
линомы различных порядков, прямое линейное преобразование, параллель-
но-перспективная модель), которые используют полиномиальную и другие 
зависимости для установления связи между плоской системой координат 
снимка и пространственной системой координат местности. Достоинством 
этих методов является отсутствие необходимости использования сведений о 
параметрах съемки и сенсоре. К недостаткам полиномиальных методов 
можно отнести необходимость измерения координат большого количества 
опорных точек, расположенных равномерно по снимку. 

Для трансформирования сканерных снимков полиномы различного 
порядка получили весьма широкое распространение. В общем виде поли-
ном можно записать следующим образом: 
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где х, у –  координаты точки на изображении; 
Х, Y  –  координаты точки на местности; 

0 0ij ija ,a ,b ,b  –  коэффициенты полиномов; 

n – степень полинома. 
Количество опорных точек должно быть не менее чем 1 2 2( n )( n ) /  . 

Рассмотрим алгоритм трансформирования снимков с использованием 
полиномов на примере аффинного преобразования: 
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21 

Аффинное преобразование выполняет поворот, масштабирование  
и сдвиг изображения. Для трансформирования с использованием аффинного 
преобразования нужны минимум 3 точки, не лежащие на одной прямой. При 
трансформировании необходимо измерить координаты опорных точек  
на снимке (в системе координат цифрового изображения). Имея координаты 
точек в системе координат цифрового изображения и во внешней (геодезиче-
ской) системе координат, можно вычислить коэффициенты полиномов, после 
чего при помощи рассчитанных коэффициентов – координаты точек изобра-
жения в геодезической системе координат. Кроме аффинного преобразования 
часто при трансформировании используется полином второй степени: 
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                (9) 

 

Для определения коэффициентов 0 1 2 3 4 5 0 1 2 3 4 5, , , , , , , , , , ,a a a a a a b b b b b b

полинома второй степени необходимо минимум 6 опорных точек, но 
обычно при трансформировании снимков для обеспечения надежного ре-
зультата их требуется значительно больше. Полином второй степени вно-
сит в изображение искажения, нарушающие прямолинейность исходных 
линий, что может быть весьма заметно на снимках городской территории. 

Кроме полинома второй степени программные продукты по обработ-
ке данных дистанционного зондирования, как правило, позволяют исполь-
зовать полиномы и более высоких порядков, но использование таких по-
линомов вносит в геометрию изображения значительные искажения. Кро-
ме того, увеличивается минимальное количество опорных точек, поэтому 
полиномы выше второй степени реже применяются на практике. 

Еще одним методом трансформирования, используемым в программ-
ных продуктах, является прямое линейное преобразование (DLT – Direct 
Linear Transformation) [21]  
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где X, Y ,Z – координаты точки на местности; 
Ai, Bj, Ck – параметры модели. 
Для расчета коэффициентов модели DLT необходимо минимум  

6 опорных точек, но при трансформировании космических снимков не ре-
комендуется использовать меньше 10. 

2.4. Трансформирование космических снимков 
с использованием RPC 

В сентябре 1999 г. был запущен спутник IKONOS, который стал пер-
вым коммерческим космическим аппаратом дистанционного зондирова-
ния  
с пространственным разрешением 1 м. Компания Space Imaging – владе-
лец спутника – для обработки снимков включила в комплект поставки по-
требителю файл с коэффициентами рациональных полиномов RPC 
Rational Polynomial Coefficients, что позволило не раскрывать точных па-
раметров системы для применения строгих фотограмметрических формул, 
а многочисленные исследования показали, что такой подход позволяет 
получать точности, сопоставимые с применением строгой модели [22].  

RPC в настоящее время является стандартным методом фотограммет-
рической обработки космических снимков высокого и сверхвысокого раз-
решения. Рациональные полиномы представляют собой функции вида 
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где rn, cn – нормированные координаты строк и столбцов снимка; 
LineNumCoef – список 20 коэффициентов для строки (полином числи-

теля); 
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LineDenCoef – список 20 коэффициентов для строки (полином знаме-
нателя); 

SamNumCoef – список 20 коэффициентов для столбца (полином чис-
лителя); 

SamDenCoef – список 20 коэффициентов для столбца (полином зна-
менателя). 

В модели RPC используются нормализованные координаты 
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где LatOff –  сдвиг по широте, °; 
LonOff –  сдвиг по долготе, °; 
Latitude – широта; 
Longitude – долгота; 
LinOff – сдвиг строки в пикселах; 
SamOff –  сдвиг колонки в пикселах; 
HgtOff – сдвиг высоты в метрах; 
LinScale – нормализующий коэффициент для строки; 
SamScale – нормализующий коэффициент для столбца; 
LatScale – нормализующий коэффициент для широты; 
LonScale – нормализующий коэффициент для долготы; 
HgtScale – нормализующий коэффициент для высоты. 



24 

Числитель и знаменатель рациональной функции полиномиального 
уравнения представляет собой полиномы третьего порядка вида [22] 

 

1 2 3 4 5 6 7

2 2 2 3 3 2
8 9 10 11 12 13 14

2 3 2 2 2 3
15 16 17 18 19 20

( , , )

.

f P L H c c L c P c H c LP c LH c PH

c L c P c H c PLH c L c LP c LH

c L P c P c PH c L H c P H c H

       

       

     
        (17)

  

Внешнее ориентирование снимков с помощью RPC-модели можно 
выполнять без опорных точек, при этом средние квадратические ошибки 
на равнинной местности будут составлять в среднем около 3–7 м. Для 
ориентирования снимков с точностью 1–3 м или лучше рекомендуется 
уточнить RPC по опорным точкам. Количество точек зависит от рельефа 
местности и типа сенсора. Так, для снимков Pleiades и WorldView доста-
точно использовать всего одну опорную точку (параллельный сдвиг) для 
значительного увеличения точности, а, например, для снимков QuickBird 
необходимо не менее трех опорных точек (сдвиг, разворот и масштабиро-
вание). 

В прил. 1 представлено содержимое файла RPC, входящего в ком-
плект поставки космического снимка QuickBird [23–29]. 

2.4.1. Состав комплекта поставки космических снимков 

Рассмотрим подробнее, какие данные входят в комплект поставки кос-
мического снимка, на примере снимка QuickBird уровня обработки Orthorea-
dystandart (с уровнями обработки снимков можно ознакомиться в [15]): 

 файл BASE.TXT содержит текст лицензионного соглашения  
с пользователем; 

 файл README.TXT – информационный файл; 

 файл BROWSE.JPG представляет собой обзорный снимок  
в формате jpeg, предназначенный для предварительного просмотра снимка 
без использования специализированного программного обеспечения; 

 файлы с расширениями IMD (imagemetadata) и XML содержат мета-
данные снимка (дата съемки, уровень обработки, параметры привязки и т. д.); 

  файл с расширением RPB содержит RPC; 
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  файл с расширением TIF – снимок; 

  файл с расширением TIL (прил. 2) содержит имена и координаты 
тайлов. Тайловая структура используется для работы с растровыми изоб-
ражениями большого размера. Такая организация данных позволяет быст-
ро считывать с диска и отображать на экране отдельные участки целого 
снимка. 

Если изображение состоит из отдельных тайлов, то файл RPC будет 
использоваться для целого изображения, составленного из тайлов.  

Файл TIL содержит в себе имена соответствующих тайлов и коорди-
наты их углов во внешней системе координат и системе координат цифро-
вого изображения. 
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3. АВТОМАТИЗАЦИЯ ПОИСКА СООТВЕТСТВЕННЫХ ТОЧЕК 

3.1. Детекторы и дескрипторы 

Поиск и идентификация соответственных точек – одна из распростра-
ненных задач, возникающих при обработке данных дистанционного зон-
дирования. Задача поиска соответственных точек имеет место при кореги-
страции космических снимков, выполнении взаимного ориентирования 
аэроснимков, а также при построении цифровых моделей рельефа стерео-
фотограмметрическим способом. 

Первые исследования в области автоматизации стереоскопических 
измерений были выполнены в МИИГАиК профессором А. С. Скиридовым 
в 1924–1932 гг. Но в то время из-за недостаточно высокого уровня разви-
тия технических средств эти исследования не привели к широкому приме-
нению методов автоматизации на практике. В настоящее время алгоритмы 
отождествления соответственных участков изображений нашли широкое 
применение в специализированном программном обеспечении [19]. 

Для поиска и идентификации соответственных точек сперва необхо-
димо выявить некие локальные особенности (экстремумы) на изображе-
ниях, выполнить их описание и лишь потом идентифицировать на смеж-
ных изображениях по описанию. Для решения этой последовательности 
задач применяется два типа алгоритмов – детекторы (их задача – выявить 
локальные особенности на изображении) и дескрипторы (алгоритмы опи-
сания точки). При визуальном поиске соответственных точек оператор 
выбирает на перекрывающихся снимках локальные участки с хорошо раз-
личимым экстремумом яркости, например камни, а при определенном 
разрешении – пни деревьев или крышки канализационных люков. Хоро-
шим вариантом точки являются углы бордюров, дорожной разметки, фун-
даментов зданий и т. д. Для автоматического выявления на изображении 
точек, образованных сходящимися или пересекающимися гранями  
(т. е. углов), применяются алгоритмы – детекторы углов, такие как 
Moravec, Harris, Shi-Tomasi, Förstner и т. д. [21]. 

Для описания обнаруженных локальных особенностей распростране-
ние получили так называемые площадные алгоритмы. Ключевым в таких 
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алгоритмах является понятие площадного образа (дескриптора) – некото-
рой произвольной по размеру области снимка. С математической точки 
зрения образ представляет собой матрицу R как совокупность элементов 
изображения (пикселов), каждый из которых характеризуется положением 
и значением яркости. Опознавание точки левого снимка на правом (при 
идентификации точек на стереопаре) сводится к определению эталонного 
образа R на левом снимке с центром в отождествляемой точке и поиску 
максимально похожего образа на правом снимке. Практически для авто-
матического опознавания точки нужно выполнить следующие действия. 

На левом снимке необходимо выбрать образ r в виде области разме-
ром m × n пикселов. На правом снимке определить зону R поиска разме-
ром M × N пикселов (R>>r). Далее необходимо в границах зоны поиска 
размером M × N на правом снимке создать с определенным шагом 
(например один пиксел) серию образов ri или сформировать образы точек, 
выделенных дескриптором в области поиска, и определить меру близости 
между образом с левого снимка с множеством образов, находящихся в об-
ласти поиска на правом. В качестве меры близости между образами могут 
выступать различные функции. Распространение получил алгоритм, пред-
ложенный еще профессором А. Н. Лобановым и основанный на расчете 
коэффициентов нормированной корреляции между оптическими плотно-
стями элементов (значениями яркости пикселов) образа на левом снимке и 
множеством образов из зоны поиска на правом снимке. Автоматические 
измерения выполняются путем вычисления нормализованной корреляции 
по формуле  

 

 
   

   
0 0

2 2

0 0 0 0

, τ, ν

τ,ν
, τ, ν

M N

x y
M N M N

x y x y

P x y P x y

K
P x y P x y

 

   

 

   

 


 
, (18) 

 

для 1τ 0 k  , 2ν 0 k  , где 1 2k k   – это размер участка эталона; M N  – 

размер зоны. Очевидно, что искомая точка лежит в центре образа на пра-
вом снимке с максимальным коэффициентом корреляции.  
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Размер выбираемого образа напрямую зависит от пространственного 
разрешения снимков и местности, отображенной на снимках. Размер зоны 
поиска на правом снимке должен превышать удвоенные ожидаемые сме-
щения точек, вызванные влиянием рельефа местности. 

Алгоритм идентификации соответственных точек на основе взаимной 
корреляции устойчиво работает только при взаимных углах наклона  

и разворота снимков, не превышающих 20–30, разномасштабности 

снимков менее 20–30 % и при условии, что снимаемая местность плоская 
[19, 21]. 

3.2. Метод идентификации соответственных точек SIFT 

Для поиска и идентификации соответственных точек на снимках 
необходимо, чтобы признаки, описывающие характерные точки, были 
инвариантны к таким факторам, как изменение освещенности, 
разномасштабность, углы разворота и сдвиг. Этим критериям 
соответствует алгоритм SIFT (Scale Invariant Feature Transform), 
запатентованный в 2004 г. Дэвидом Лоу [30] (действие патента 
закончилось в 2020 г.). 

Идентификация точек с помощью SIFT включает в себя несколько 
этапов. 

На первом этапе проводится гауссова фильтрация изображения  
и создается гауссова пирамида изображений (инвариантность к разно-
масштабности достигается благодаря анализу изображения на разных 
уровнях пирамиды, т. е. при разном масштабе). Фильтрация выполняется 
путем свертки двумерной функции изображения и функции Гаусса 

( , , ) ( , ) ( , , );L x y P x y G x yj j jI    (19) 
 

2 2 2( )

2

1
( , , ) ,

2πσ
jx y

j
j

G x y e
                                 (20)

 
 

где σ2 – дисперсия. 
На рис. 15 изображен график функции Гаусса. 
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Рис. 15. Трехмерный график функции Гаусса 
 
 

Новый уровень пирамиды Гаусса формируется путем прореживания 
каждого второго пиксела изображения предыдущего уровня. 

Каждый уровень пирамиды состоит из нескольких изображений, 
полученных путем фильтрации гауссианом с различной σ2. Эти 
изображения формируют так называемую октаву. 

Затем подчеркиваются контуры путем определения разностного 
изображения для соседних уровней в октавах гауссова пространства 
изображений. Это так называемый DoG (Difference of Gaussian) фильтр 
(рис. 16, 17). Количество изображений в октаве каждого уровня 
получившейся DoG-пирамиды на 1 меньше, чем в октавах пирамиды 
Гаусса. График разностной гауссовой функции представлен на рис. 16. 

 

 

Рис. 16. Трехмерный график разностной гауссовой функции DoG 
(Difference of Gaussian) 
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Схема получения DoG-пирамиды из пирамиды Гаусса представлена 
на на рис. 17. 

 

 

Рис. 17.  Уровни гауссовой и DoG-пирамид 
 
 
На следующем этапе выполняется выделение характерных точек 

(локальных экстремумов) на разностном изображении Dj (x, y, σj),  

с помощью маски 3  3 элемента вычисляется разность между значениями 

яркости центральной точки и восемью соседними элементами уровня j,  
а также соответствующими девятью элементами изображения Dj+1 (x, y, σj+1) 
уровня выше и девятью элементами нижележащего уровня Dj–1 (x, y, σj–1). 

Далее выполняется описание локальной области выделенной вокруг 
точки путем задания масштаба и ориентации локальной системы 
координат, связанной с этой локальной областью. Локальная область 
определяется «масштабом», радиусом r  окружности с центром в точке m  
и начальным направлением, заданным как направление максимального 
градиента. 

Величина градиента  gr x,y  и угол, определяющий ориентацию 

локального изображения, вычисляются по формулам: 
 

           1 1 1 1
2 2

gr x, y L x , y L x , y L x, y L x, y ,          (21) 
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1 ( ( , 1) ( , 1)
( , ) tan

( ( 1, ) ( 1, )

L x y L x y
x y

L x y L x y
    

      
. (22) 

 

Таким образом, локальная область задает локальную систему 
координат и описывается с помощью параметров: x, y – координаты 
характерной точки в системе координат исходного изображения, θ – угол 
между осью x и начальным направлением, определенным как максимум 
градиента в окрестности точки. 

На последнем этапе выполняется описание точки с помощью 
градиентов по направлениям, заданным относительно ориентации 
локальной области. Точка описывается вектором, размерность которого 
зависит от размера локальной области. Алгоритм SIFT применяется к паре 
изображений, а затем выполняется идентификация соответственных точек 
по вектору признаков. 

К плюсам SIFT можно отнести инвариантность по отношению к сдвигу, 
развороту, масштабу (разномасштабность может быть 4-кратной)  
и изменению яркости. Признаки также устойчивы к шумам и теням. 

Главным недостатком алгоритма является большое количество 
вычислений, что требует значительных затрат ресурсов компьютера [31]. 
 

3.3. Построение плотных цифровых моделей поверхности 

Цифровая модель поверхности (ЦМП, англ. DSM – Digital Surface 
Model) – модель, образованная множеством точек, расположенных на 
видимых открытых поверхностях снимаемой местности, и включающая  
в себя цифровую модель рельефа и цифровую модель объектов (ЦМО). При 
построении таких моделей стереофотограмметрическим способом 
применяются алгоритмы отождествления соответственных точек, которые 
можно разделить на 3 группы: локальные, глобальные и полуглобальные.  
К первой группе относят алгоритмы, выполняющие поиск соответствий 
между точками, обнаруженными на снимках детектором (Moravec, Harris, 
Shi-Tomasi, Förstner и т. д.); отождествление точек выполняется по дескрип-
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торам (например, отождествление площадных дескрипторов при помощи 
функции корреляции Пирсона). 

При построении плотных цифровых моделей глобальным методом 
для каждого пикселя левого изображения выполняется поиск соответ-
ствующего пикселя на правом [21]. 

Каждой точке на одном из двух изображений стереопары соответству-
ет прямая на втором изображении, называемая эпиполярной линией. Эпипо-
лярные линии (базисные линии) – это линии пересечения базисных плоско-
стей стереопары с плоскостями снимков. При известных параметрах ориен-
тирования снимков поиск соответственной точки можно ограничить лишь 
отвечающей ей базисной линией на втором изображении (рис. 18). Высотная 
отметка точки зависит от ее положения на базисной линии.  

 

 

Рис. 18. Эпиполярные линии 
 
Для упрощения поиска точек на практике используют трансформи-

рованные изображения, на которых базисные линии совпадают со строка-
ми пикселей (рис. 19).  

Для поиска соответствия точки с множеством точек на эпиполярной 
(базисной) линии второго изображения могут применяться различные 
способы отождествления, например, уже рассмотренный площадной кор-
реляционный алгоритм или разности яркостей пикселей. 

Поиск по всей строке с шагом в один пиксел в масштабе всего изобра-
жения требует больших вычислительных ресурсов и очень много времени 
даже при использовании мощных графических станций. Для сокращения 
количества шагов (а значит, и времени) при поиске точек применяются ал-
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горитмы оптимизации. Примерами таких алгоритмов могут быть метод гра-
диентного спуска, метод имитации отжига (используется для построения 
цифровых моделей рельефа в программном комплексе SkanEx Image Proces-
sor) [32], метод динамического программирования и т. д. 

 

 

Рис. 19.  Поиск точек на эпиполярных изображениях 
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4. АЛГОРИТМЫ СЛИЯНИЯ ИЗОБРАЖЕНИЙ. PANSHARPENING 

Современные космические съемочные системы высокого и сверх-
высокого разрешения, как правило, выполняют съемку в панхроматическом, 
охватывающем видимый диапазон, и нескольких узких спектральных 
каналах. Пространственное разрешение панхроматическомго канала обычно 
в 2–4 раза выше мультиспектрального сенсора. Для увеличения прост-
ранственного разрешения мультиспектрального изображения применяются 
специализированные алгоритмы получения синтезированных изображений  
с увеличением пространственного разрешения [33]. При разработке таких 
алгоритмов первостепенной задачей является улучшение качества резуль-
тирующего изображения и уменьшение яркостных искажений. В спе-
циализированном программном обеспечении широкое применение нашли 
методы PCA, IHS, Brovey Transform и др. [33]. 

Синтезирование на основе метода главных компонент (PCA – 
Principal Component Analysis).   

Сущность метода главных компонент заключается в том, что вектор 
яркостей для элемента многоспектрального изображения выглядит как 

 

 I II k
ij ij ij ijP P ,P , ,P  , (23) 

 

где k – количество каналов;  
ij – номер пикселя. 
В результате преобразования каждое из изображений получается ли-

нейно-независимым от изображений в других каналах [33].  
Для этого используется преобразование Карунена – Лоева, в резуль-

тате которого рассчитывается матрица собственных векторов ковариаци-
онной матрицы и вектор собственных значений, удовлетворяющие усло-
вию 

 

λT
ijU K U  , (24) 
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где ijK  – ковариационная матрица; 

U – матрица, составленная из собственных векторов ковариационной 

матрицы ijK ; 

 – собственные значения, соответствующие собственным векторам 
матрицы U. 

Затем вычисляется преобразованное изображение: 
 

T
ijij UPUP 

2
. (25) 

 

В результате применения преобразования оси координат спект-
рального пространства поворачиваются так, чтобы первая главная 
компонента соответствовала наибольшей оси эллипсоида рассеяния – 
направлению наибольшего разброса значений яркости. Вторая главная 
компонента будет соответствовать наибольшему поперечному сечению 
эллипсоида, ортогональному к первой главной компоненте. Она отражает 
наибольшее значение разброса данных, которые еще не охвачены первой 
главной компонентой. Каждая последующая компонента является одним 
из поперечных сечений эллипсоида рассеяния, ортогональным к пре-
дыдущим сечениям (компонентам), и характеризует снижающее значение 
вариаций в данных, еще не учтенных предыдущими главными 
компонентами, поэтому первые из них содержат большую часть 
информации мультиспектрального изображения [33]. 

Первая главная компонента по информативности близка к панх-
роматическому (Pan) изображению, поэтому при слиянии первая главная 
компонента заменяется панхроматическим снимком высокого разрешения 
[33]. Схема слияния изображений по методу PCA описывается формулой  
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1

'
2 2
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B PC PC B
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 (26) 

 

Операция слияния состоит из следующих этапов: преобразование 
мультиспектрального изображения по методу главных компонент, замена 
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первой главной компоненты на панхроматическое  изображение высокого 
разрешения, обратное преобразование главных компонент (вместе с панх-
роматическим изображением). После обратного преобразования получаем 
синтезированное изображение высокого разрешения. 

Преобразование «интенсивность – оттенок – насыщенность» –  
(Intensity, Hue, Saturation) IHS. 

При использовании этого метода цветное  изображение из прост-
ранства RGB (рис. 20) трансформируется в IHS (рис. 21).  

 

 

Рис. 20.  Пространство RGB 
 
 

 

Рис. 21.  Пространство IHS 
 
 
IHS-преобразование  описывается соотношениями [8, 11, 14]: 
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После выполнения преобразования в пространство IHS компонента  
I цветного изображения заменяется на изображение высокого разрешения 
из панхроматического канала. Затем выполняется обратное преоб-
разование в пространство RGB. Преобразование из IHS в RGB выпол-
няется по следующим формулам. 

Сектор RG (0 <= Н < 120°): 
 

B=I⸱(1 – S), (31) 
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S H
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 (32) 

 

G=3⸱I – (R+B). (33) 
 

Сектор GB (120° <=Н < 240°): 
 

H=H – 120°, (34) 
 

R=I⸱(1 – S), (35) 
 

cos( )
1

cos(60 )

S H
G I ,

H

 
     

 (36) 

 

B=3⸱I – (R+G). (37) 
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Сектор BR (240° <= Н <= 360°): 
  

H=H – 240°, (38) 
 

G=I⸱(1 – S), (39) 
 

cos( )1
cos(60 )

S HB I
H

 
 
 

  
 , (40) 

 

R=3⸱I – (G + B).   (41) 
 

Схема  синтеза  по  методу  IHS  характеризуется формулой (28).   
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  (42) 

 
Brovey Transform.  
Для получения каждой из трех компонент цветного изображения по ме-

тоду Brovey Transform панхроматическое изображение перемножается  
с масштабированным изображением одного из спектральных каналов и де-
лится на сумму изображений красного, зеленого и синего каналов (30) [33]: 
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  (43) 

 

Метод Brovey Transform был разработан для повышения визуального 
контраста  в нижних и верхних частях гистограммы (т. е. он позволяет 
обеспечить контраст в тени, водных поверхностях и в областях с высокой 
отражательной способностью). Поэтому этот метод не пригоден для  
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сохранения высоких радиометрических характеристик исходного изо-
бражения. 

Программные комплексы, реализующие процедуру слияния изоб-
ражений. 

В наиболее распространенных программных комплексах (ПК) 
обработки данных ДЗЗ, таких как ENVI, PCI Geomatica, ERDAS, ScanEx 
Image Processor и др. реализованы различные методы слияния изоб-
ражений. В ПК ENVI 4.2 используются 5 алгоритмов (обозначенных как 
Transforms-Image Sharpening): IHS, Color Normalized (Brovey), Gram-
Schmidt Transform, PCA и CN Spectral. В базовой поставке ПК ERDAS 
реализованы 3 разновидности таких алгоритмов (PC, Multiplicative  
и BroveyTransform). В программном комплексе ScanEx Image Processor 
реализован алгоритм, основанный на сочетании метода главных 
компонент и метода вейвлет-преобразования [21]. 
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5. ПРАКТИЧЕСКИЙ КУРС 

5.1. Лабораторная работа № 1  

Трансформирование космических снимков  

Цель: изучение теоретических основ и получение практических навы-
ков трансформирования космических снимков в программном комплексе 
ENVI. 

Задачи:  

 выполнить трансформирование снимков при помощи методов, реа-
лизованных в инструменте «image to image» программного комплекса 
ENVI (аффинное преобразование, полиномиальный, триангуляция Де-
лоне); 

 изучить доступные в программном обеспечении методы интерполя-
ции; 

 выполнить оценку точности результатов трансформирования и за-
полнить таблицу из прил. 3.  

Используемое программное обеспечение: ENVI, MS Excel. 
Исходные данные: трансформированный панхроматический космиче-

ский снимок SPOT(пространственное разрешение 10 м). 
Нетрансформированный мультиспектральный космический снимок 

Landsat 5 TM (пространственное разрешение 30 м). 

Порядок выполнения работы 

1. Загрузить снимки. 
2. Выполнить измерение координат соответственных точек (27–30 

равномерно расположенных точек). 
3. Исключить 10 точек из процесса трансформирования (контрольные 

точки) и выполнить трансформирование снимка при помощи полиномов 
1-й, 2-й, 3-й степеней, аффинного преобразования и триангуляции Делоне. 
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4. Выполнить трансформирование теми же методами с использовани-
ем минимально возможного для каждого из методов количества опорных 
точек. Выполнить оценку точности по 10 контрольным точкам с исполь-
зованием таблицы MS Excel (см. прил. 3, табл. П.3.1). Заполнить табл. 
П.3.2, прил. 3. При выполнении трансформирования с использованием по-
линома 3-й степени использовать различные методы интерполяции. Сде-
лать выводы об изменении качества трансформированного изображения  
и точности измерения контрольных точек в зависимости от использован-
ного метода интерполяции. 

5. Оценка точности и заполнение табл. П.3.1 прил. 3; 
6. Написание отчета. 
В качестве методических указаний в лабораторной работе можно ис-

пользовать учебное пособие Л. Г. Евстратовой «Трансформирование кос-
мических снимков с использованием программного комплекса ENVI». 

Требования к отчету 

Отчет должен быть оформлен согласно требованиям СТО СГУГиТ  
и должен содержать теоретическое описание использованных методов 
трансформирования и интерполяции, скриншоты основных этапов транс-
формирования, схемы расположения опорных и контрольных точек, 
скриншоты трансформированных изображений, таблицу с результатами 
оценки точности, выводы об эффективности использованных методов 
трансформирования и интерполяции.  

Для защиты отчета по лабораторной работе необходимо прокоммен-
тировать результаты из табл. П.3.2 и ответить на следующие вопросы. 

1. Характеристики съемочных систем Landsat5 и SPOT4. 
2. Современные космические съемочные системы среднего простран-

ственного разрешения. 
3. Полиномиальные методы трансформирования снимков. 
4. Количество точек, необходимое для трансформирования снимка  

с использованием полиномов 1-й, 2-й, 3-й степеней. 
5. Методы интерполяции, используемые при трансформировании 

снимков в программном комплексе ENVI. 
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5.2. Лабораторная работа № 2  

Использование автоматизированных методов поиска 
соответственных точек 

Цель: изучение теоретических основ и применение на практике мето-
дов автоматизированного поиска соответственных точек. 

Задачи: 
– выполнить поиск соответственных точек на стереопаре космических 

снимков IKONOS при помощи алгоритма SIFT; 
– выполнить поиск соответственных точек на стереопаре космических 

снимков IKONOS при помощи алгоритма, реализованного в ПК ENVI; 
– проанализировать результаты применения использованных алго-

ритмов; 
Используемое программное обеспечение: ENVI, MATLAB. 
Исходные данные: фрагмент стереопары космических снимков IKO-

NOS. 

Порядок выполнения работы 

1. Поиск соответственных точек на стереопаре космических снимков 
в среде MATLAB. 

2. Отбраковка точек в ENVI. 
3. Автоматизированный поиск соответственных точек на стереопаре 

космических снимков в ENVI (с использованием настроек коррелятора, 
выставленных по умолчанию). 

4. Отбраковка точек в ENVI. 
5. Автоматизированный поиск соответственных точек на стереопаре 

космических снимков в ENVI (с самостоятельно введенными параметрами 
коррелятора). 

6. Анализ результатов. 
7. Автоматизированный поиск соответственных точек на разномас-

штабных космических снимках в среде MATLAB и ENVI. 
8. Написание отчета. 
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Описание программы, реализованной в среде MATLAB для поиска 
соответственных точек по методу SIFT. 

Программа, использованная в лабораторной работе, написана  
в университете Британской Колумбии (Канада) и реализует метод SIFT, 
разработанный профессором Дэвидом Лоу. Запуск программы 
осуществляется в среде MATLAB при помощи м-файла siftcomp.m. Также 
частью программы являются компоненты: sift.m, plotframe.m, 
plotsiftdescriptor.m, appendimages.m. Непосредственно сам поиск точек 
осуществляется исполняемым файлом siftWin32.exe. 

М-файл sift.m считывает изображение и возвращает 128-мерные 
векторы-дескрипторы точек; остальные м-функции служат для 
интерпретации и визуализации результатов. 

Методические указания 

Поиск соответственных точек на стереопаре космических сним-
ков в среде MATLAB. 

Выполнение работы начинается с запуска MATLAB и загрузки m-
файла siftcomp.m: File> Open> адрес рабочей директории/siftcomp.m. 

В файле siftcomp.m, открывшемся в редакторе m-файлов, необходимо 
прописать имена левого и правого изображений в форматах *.png и *.pgm. 
На первом этапе работы используется фрагмент стереопары снимков 
IKONOS (в папке с заданием это файлы А.png, В.png, А.pgm и В.pgm). За-
пускаем программу при помощи кнопки Run или клавиши F5. 

Если программа сработала корректно, то на каждом из снимков 
должно быть найдено около 2 300 точек (количество точек на левом  
и правом снимках выводится в основном окне MATLAB), причем их ко-
личество на левом и правом снимках различно. На рис. 22 и 23 представ-
лен результат работы метода SIFT в среде MATLAB. 
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Рис. 22. Результат поиска точек  
 
 
На рис. 22 в виде желтых квадратов изображены образы точек; их 

размер зависит от уровня масштаба, на котором была обнаружена точка. 
 

 

Рис. 23. Результат сопоставления точек на снимках IKONOS 
 
 
Координаты точек программа сохраняет в рабочую директорию  

в файле myfile.pts, который можно использовать в ENVI. 
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Отбраковка точек в ENVI. Отбраковка некорректно измеренных то-
чек выполняется в программном комплексе ENVI. Для этого в главном 
меню ENVI необходимо выбрать File>Open Image File. В открывшемся 
диалоговом окне выберите рабочую директорию с изображениями А.png и 
В.png, затем, для визуализации изображений во вьювере, в окне Available 
Band List выберите Gray Scale, укажите снимок А.png и нажмите на Load 
Band. Открываем новый вьювер (кнопка New Display) и по аналогии за-
гружаем изображение В.png. Далее в главном меню выбираем вкладку 
Map>Registration>SelectGCPs: Image to Image. В открывшемся окне Image 
to Image Selection в качестве базового изображения (Base Image) укажите 
А.png, в качестве трансформируемого (Warp Image) – В.png. В окне 
Ground Control Point Selection загрузите файл с координатами точек 
myfile.pts (File>RestoreGCPs from ASCII…), затем нажмите на кнопку 
Show List и в появившемся окне Image to ImageGCP List выполните отбра-
ковку точек до величины средней квадратической ошибки (RMS Error) не 
больше 1 пиксела. Для удобства отбраковки выстроите в окне Image to Im-
ageGCP List при помощи Options>Order Points by Error точки в порядке убы-
вания ошибки RMS(∆ХУ). Результат отбраковки точек показан на рис. 24.  
 

 

Рис. 24. Точки до и после отбраковки 
 
 
Для последующего использования координаты точек левого и правого 

изображений необходимо сохранить в файле *.pts (Save GPS to ASCII…). 
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Журнал измерений, отображаемый в окне Image to Image GCP List, нужно 
сохранить для отчета (File>Save Table to ASCII…). 

Автоматизированный поиск соответственных точек на стереопа-
ре космических снимков в ENVI. 

На первом этапе выполняем загрузку изображений А.png и В.png.  
и выбираем Map>Registration>SelectGCPs: Image to Image, выбираем базо-
вый и трансформируемый снимки. Функция автоматизированного поиска 
точек (Automatically Generate Tie Points) доступна в Ground Control Point Se-
lection>Options. Прежде чем выполнять автоматизированный поиск точек, 
необходимо вручную измерить координаты не менее четырех точек или за-
грузить файл *.pts с координатами точек (в рабочей директории есть файл 
1234.pts). При выборе Automatically Generate Tie Points появляется окно вво-
да параметров коррелятора Automatic Tie Points Parameters (рис. 25). 

 

Рис. 25.  Окно Automatic Tie Points Parameters 
 
 
В окне Automatic Tie Points Parameters доступны для ввода следую-

щие параметры поиска соответственных точек: 
Number of Tie Points – необходимое количество точек; 
Search Window Size – размер окна поиска, т. е. области, в пределах 

которой будет осуществляться поиск наилучшего соответствия образу 
точки левого изображения. Этот параметр зависит от качества первона-
чальной привязки и вычисляется следующим образом. В меню 
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Tools>Link>Geographic Link необходимо установить On напротив номе-
ров соответствующих дисплеев (рис. 26). 
 

 

Рис. 26.  Geographic Link 
 
Затем кликнуть два раза левой клавишей мыши, наведясь указателем 

на пиксел, принадлежащий точке с первого изображения; при этом указа-
тель во втором окне переместится примерно в это же место. Необходимо 
посчитать, на сколько пикселов указатель на втором изображении оказал-
ся удален от искомого. Размер окна поиска для этого пиксела может быть 
рассчитан как 2*(расстояние в пикселах +1). При этом окно поиска долж-
но быть всегда значительно больше скользящего окна и не может быть 
меньше 21 пиксела. 

Moving Window Size – размер скользящего окна (образа точки) в пик-
селах. От размера скользящего окна зависит скорость и точность работы 
алгоритма. При увеличении размера скользящего окна снижается скорость 
обработки, но увеличивается точность. Минимальный размер скользящего 
окна 5 × 5 пикселов. Существуют рекомендации по выбору размера сколь-
зящего окна для снимков различного разрешения. При разрешении сним-
ков до 10 м рекомендованный размер 9–15 пикселов; 5–10 м – 11–21 пик-
селов; при разрешении 5–1 м размер окна 15–41 пикселов; при сверхвысо-
ком пространственном разрешении скользящее окно должно иметь размер 
от 21 до 81 пиксела. 
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Area Chip Size – размер окрестности (окна), в которой выполняется 
поиск экстремума яркости, т. е. точки. По умолчанию установлен размер 
121 × 121, минимальное значение 64, максимальное 2 048. Большие раз-
меры параметра наилучшим образом подходят для малоконтурной мест-
ности. 

Minimum Correlation – минимальное значение корреляции. Стоит 
помнить, что чем больше значение корреляции, тем более надежно вы-
полняется сопоставление точек, но их количество может в значительной 
мере уменьшаться. 

Point Oversampling – этот параметр указывает, сколько экстремумов 
используется в пределах одной области (Area Chip Size). 

Interest Operator – выбор метода поиска точки (Moravec или Förnster). 
Если оставить параметры, установленные по умолчанию, то на ис-

пользуемой в лабораторной работе стереопаре коррелятор обнаружит по-
рядка пятнадцати точек. Нетрудно заметить, что множество точек распо-
ложены неправильно (положение точек на правом изображении не соот-
ветствует положению соответственных точек на левом снимке). Далее 
необходимо выполнить отбраковку точек (как в предыдущем примере с 
методом SIFT). Результат отбраковки точек показан на рис. 27. Сохраняем 
для последующего использования координаты точек и Image to Image GCP 
List в текстовые файлы. 

 

 

Рис. 27.  Точки до и после отбраковки 
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Автоматизированный поиск соответственных точек на стереопа-
ре космических снимков в ENVI (с самостоятельно введенными па-
раметрами коррелятора). Познакомившись с основными настройками 
коррелятора и рекомендациями по их выбору, а также опираясь на теоре-
тические знания, полученные на лекционных занятиях, подберите пара-
метры, обеспечивающие более надежный результат по сравнению с 
настройками, установленными по умолчанию. Проанализируйте результа-
ты, полученные по методу SIFT, и алгоритмом, использующимся в ENVI. 

Выполните автоматизированный поиск соответственных точек на 
разномасштабных снимках по методу SIFT и алгоритмом, использующим-
ся в ENVI с самостоятельно введенными параметрами коррелятора. Про-
анализируйте результат. 

Требования к отчету 

Отчет должен быть оформлен согласно требованиям СТО СГУГиТ. 
Отчет должен содержать теоретическое описание использованных мето-
дов автоматизированного поиска соответственных точек, скриншоты  
и описание основных этапов работы в среде MATLAB и ENVI, схемы рас-
положения точек, журналы измерений, выводы об эффективности исполь-
зованных методов автоматизированного поиска точек.  

Для защиты отчета по лабораторной работе необходимо проанализи-
ровать полученные результаты и ответить на следующие вопросы. 

1.  Метод взаимной корреляции для поиска точек. 
2. Уголковые детекторы. 
3. Схема работы метода SIFT. 
4. Преимущества и недостатки методов, использованных в лабора-

торной работе. 
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5.3. Лабораторная работа № 3 

Построение ЦМР по стереопаре космических снимков 

Цель: изучение теоретических основ построения цифровых моделей 
рельефа по стереопарам снимков и применение на практике полученных 
теоретических знаний. 

Задачи: построить по стереопаре космических снимков цифровую 
модель рельефа в программном комплексе ENVI. Выполнить оценку каче-
ства цифровой модели рельефа. 

Используемое программное обеспечение: ENVI.   
Исходные данные: стереопара космических снимков IKONOS, полу-

ченных на городскую территорию, каталог координат опорных точек, 
файл  
с изображениями опорных точек. 

Порядок выполнения работы 

1. Построение цифровой модели рельефа в программном комплексе 
ENVI: 

а) загрузка снимков; 
б) построение эпиполярных изображений; 
в) построение цифровой модели рельефа; 
2. Оценка качества ЦМР. 

Методические указания 

Для построения ЦМР в лабораторной работе используется стереопара 
космических снимков IKONOS. Снимки расположены в папках 
po_201905_0000000 и po_201905_0010000 рабочей директории. Загружаем  
в программу снимки po_201905_pan_0000000.tif и po_201905_pan_0010000.tif. 

Чтобы приступить к построению цифровой модели рельефа, выберите 
Topographic>DEM Extraction>DEM Extraction Wizard>New. Инструмент 
DEM Extraction Wizard позволяет выполнить построение ЦМР за 9 этапов. 
На первом этапе выполняется загрузка левого (Left image) и правого (Right 
image) изображений и ввод максимальной и минимальной высот (вводится 
автоматически при наличии файла RPC). Окно загрузки стереопары пока-
зано на рис. 28. 
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Рис. 28.  DEM Extraction Wizard: Step 1 of 9 
 
На втором шаге предлагается выбрать источник опорных точек GCP 

(рис. 29).  
 

 

Рис. 29. DEM Extraction Wizard: Step 2 of 9 
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В этом окне можно выбрать No GCPs (relative DEM values only) – не 
использовать опорные точки. Define GCP interactive – выполнять измере-
ние координат опорных точек в интерактивном режиме. Read GCPs From 
File – загрузить опорные точки из файла. Для перехода на следующий этап 
выберите Define GCP interactive и нажмите на Next. В папке «Опора»  
в директории с лабораторной работой № 3 расположен файл с изображе-
ниями опорных точек «Опорные точки.docx» и текстовый файл с геодези-
ческими координатами опорных точек «Координаты.txt». Измерьте коор-
динаты шести равномерно расположенных опорных точек, вписывая гео-
дезические координаты в соответствующие поля окна DEM Extraction 
Wizard: Step 3 of 9 (рис. 30) из каталога координат «Координаты.txt». За-
тем нажмите на Next. 

 

 

Рис. 30.  Измерение координат опорных точек 
 
 
На следующем этапе выполняется поиск и измерение координат свя-

зующих точек (они используются для построения эпиполярных изображе-
ний). 

Связующие точки можно загрузить из файла Read Tie Points From 
File, выполнить поиск точек в интерактивном режиме Define Tie Points In-
teractively или найти автоматически Generate Tie Points Automatically. Вы-
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берите автоматический режим. В окне DEM Extraction Wizard появятся 
поля для ввода параметров автоматизированного поиска связующих точек 
(рис. 31). 

 

 

Рис. 31.  Настройка параметров поиска соответственных точек 
 
Оставьте предлагаемые по умолчанию значения настроек коррелятора 

и нажмите на Next. 
На рис. 32 показана схема расположения связующих точек, найден-

ных коррелятором. 
 

 

Рис. 32.  Схема расположения соответственных точек 
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В окне DEM Extraction Wizard: Step 5 of 9 расположены функции управ-
ления связующими точками. На этом этапе выполняется редактирование по-
ложения точек с целью снижения поперечного параллакса (при поперечном 
параллаксе больше 10 программа не позволяет перейти на следующий этап). 
Окно редактирования связующих точек показано на рис. 33. 

 

 

Рис. 33.  DEM Extraction Wizard: Step 5 of 9 
 
 
Стоит заметить, что из-за наличия теней от зданий и достаточно 

больших смещений точек крыш зданий (и других возвышающихся объек-
тов), вызванных большими углами наклона снимков, автоматизированный 
поиск соответственных точек на стереопаре в значительной мере затруд-
нен. Для примера на рис. 34 приведен один и тот же участок отображен-
ной на стереопаре местности. 
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Рис. 34.  Многоэтажные здания на левом и правом изображениях 
 
 
Необходимо проверить правильность положения всех точек. Для ре-

дактирования точки нужно выбрать ее номер в окне Stereo Tie Point List, 
навестись перекрестием на пиксел (на левом и правом изображениях),  
в положение которого необходимо перенести точку, и нажать на кнопку 
Update. Окно Stereo Tie Point List открывается нажатием кнопки Show Ta-
ble (рис. 35). Чем меньше значение в колонке Error Rank, тем больше 
ошибка в положении точки. 

 

 

Рис. 35.  Stereo Tie Points List 
 
 
Редактируя точки, добейтесь значения поперечного параллакса равно-

го или меньше 1 и нажмите на Next. 
Перейдя на 6-й этап, выберите директорию, в которую будут сохра-

нены левое и правое эпиполярные изображения (рис. 36). 
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Рис. 36.  Построение эпиполярных изображений 
 
 
На 7-м этапе выбирается система координат и размер элемента ЦМР 

(рис. 37). Оставьте значения, предлагаемые программой по умолчанию,  
и перейдите на следующий этап, нажав на кнопку Next. 

 

 

Рис. 37.  Параметры создаваемой ЦМР 
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Чтобы построить ЦМР по эпиполярным изображениям, на этапе 8 
необходимо задать параметры коррелятора (рис. 38). Программа будет 
осуществлять поиск соответствий для пикселов левого изображения на 
правом снимке. 

 

 

Рис. 38.  Параметры коррелятора 
 
 
Minimum Correlation – минимальное значение корреляции Background 

Value – значение, присваиваемое фоновым пикселам.  
Edge Trimming – отступ от краев исходного изображения (указывается  

в процентах). Moving Window Size – размер скользящего окна (образа точки) 
в пикселах. Terrain Relief – выбор преобладающего типа рельефа. Параметр 
Terrain Detail указывает, сколько уровней пирамиды изображения будет ис-
пользовано для поиска соответственных точек, по плоским координатам ко-
торых будут вычисляться высотные отметки ЦМР. Самый грубый результат 
получается при использовании одного уровня. Максимальное количество 
уровней для используемой стереопары равно семи. Естественно, что чем 
большее количество уровней используется, тем лучше результат,  
но и больше время, требуемое на обработку. На рис. 39 представлены ЦМР, 
полученные с использованием значения Terrain Detail 1 и 7. 
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Рис. 39.  ЦМР, построенные с использованием различного количества 
масштабных уровней изображений 

 
 

Output Data Type – тип выходных данных. 
На рис. 40 показана ЦМР, построенная с параметром Terrain Detail, 

заданным программой по умолчанию. Цифровая модель рельефа пред-
ставлена в виде матрицы в формате geo tif с размером элемента 1 м. По 
умолчанию ЦМР отображается в полутоновом режиме, но можно приме-
нить одну из множества цветовых палитр, доступных в ENVI. Для смены 
цветовой палитры выберите Tools (в окне image)>Color Mapping>ENVI 
Color Table. Как видно на рис. 40, ЦМР водной поверхности озера имеет 
значительные перепады высот, что является дефектом, так как высотные 
отметки водной поверхности стоячего водоема должны быть постоянны-
ми на всей его площади. Для исправления высотных отметок на этапе ре-
дактирования ЦМР для выделенной «Области интересов» можно задавать 
значения высот вручную. 

 

 

Рис. 40. Цифровая модель рельефа 
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Выполните редактирование ЦМР. Для этого выберите Load DEM Re-
sult to Display with Editing Tool (рис. 41). 

 

 

Рис. 41.  DEM Extraction Wizard: Step 9 of 9 
 
 
В открывшемся окне DEM Editing Tool задаются параметры редакти-

рования ЦМР (рис. 42). 
 

 

Рис. 42. DEM Editing Tool 
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В группе настроек Region of Interest задаются параметры региона ин-
тереса (тип полигона, цвет), в группе настроек Edit Pixel Values  вводится 
значение высоты (Value) и выбирается метод коррекции ЦМР (Method). 
Replace With Value – замена на значение, введенное с клавиатуры (Value). 

Replace With mean – усреднение высот внутри области интереса. 
Smooth – сглаживание. 
Median filter – используется медианная фильтрация значений, попав-

ших в регион интереса.  
Triangulate – значения высотных отметок внутри области интереса 

пересчитываются методом триангуляция Делоне с использованием высот-
ных отметок в узлах полигона.  

Thin Plate Spline – значения внутри области интересов являются ин-
терполированными при помощи сплайнов значениями высот в узлах поли-
гона области. 

В группе настроек Region of Interest выберите Polygon и обведите 
водные объекты. Затем в поле Value введите значение высоты. Результат 
представлен на рис. 43. 

 

 

Рис. 43.  Исправленная цифровая модель рельефа 
 

Требования к отчету 

Отчет должен быть оформлен согласно требованиям СТО СГУГиТ. 
Он должен содержать теоретические основы построения ЦМР по стере-
опаре снимков и краткое описание этапов построения ЦМР в программ-
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ном комплексе ENVI, с соответствующими скриншотами. Для защиты ла-
бораторной работы необходимо ответить на следующие вопросы. 

1. Алгоритмы поиска соответственных точек. 
2. Локальные и глобальные алгоритмы отождествления точек. 
3. Основные этапы построения ЦМР по стереопаре космических 

снимков в программном комплексе ENVI. 

5.4. Лабораторная работа № 4  

Ортотрансформирование космических снимков 

Цель: выполнить ортотрансформирование космического снимка с ис-
пользованием RPC-коэффициентов и ЦМР, построенной по стереопаре 
космических снимков. 

Используемое программное обеспечение: ENVI. 
Исходные данные: цифровая модель рельефа, космический снимок 

IKONOS, координаты опорных и контрольных точек, файл с изображени-
ями опорных и контрольных точек. 

ENVI позволяет использовать RPC-модель сенсора при выполнении 
ортотрансформирования космических снимков, полученных современны-
ми космическими системами высокого и сверхвысокого разрешения. Для 
выполнения ортотрансформирования кроме снимка требуются RPC-
коэффициенты и цифровая модель рельефа.  

Порядок выполнения работы 

Процедура ортотрансформирования разбита на следующие этапы.  
1. Запуск ENVI.  
2. Загрузка исходного изображения и DEM (ЦМР).  
3. Ортотрансформирование изображения.  
4. Проверка результатов ортотрансформирования.  
 
Загрузка исходного изображения и цифровой модели рельефа. Вы-

полните загрузку в программу снимка po_201905_pan_0000000.tif (снимок 
расположен в рабочей директории).  
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Загрузите цифровую модель рельефа File>Open External File>Digital 
Elevation > USGS DEM.  

Ортотрансформирование изображения. Для того чтобы приступить 
к выполнению ортотрансформирования снимка, необходимо выполнить 
загрузку модуля Orthorectification Map>Orthorectification>Orthorectify 
IKONOS. В открывшемся диалоговом окне выберите файл 
po_201905_pan_0000000.tif и нажмите на OK. 

Для обработки изображения понадобится файл с RPC-коэффициентами.  
Примечание: если ENVI не сможет найти служебный файл, содержа-

щий RPC-коэффициенты, система предложит пользователю самому ука-
зать его директорию. 

Откроется диалоговое окно для ввода параметров ортотрансформиро-
вания (рис. 44).  

 

 

Рис. 44. Диалоговое окно для ввода параметров ортотрансформирования 
 
 

В диалоговом окне введите следующие параметры: Image Resempling – 
способ определения значений (интенсивности) пиксела в изображении 
IKONOS, когда оно будет преобразовано из текущего состояния в новое. По 
умолчанию будет использоваться Bilinear (билинейная интерполяция). Ва-
рианты выбора: Cubic Convolution (кубическая свертка), Nearest Neighbor 
(ближайший сосед).  
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Примечание: если размеры пикселов цифровой модели рельефа 
больше, чем размеры пикселов изображения, выбор метода ближайшего 
соседа может привести к нежелательным последствиям. В таких случаях 
рекомендуется выбирать другие способы интерполяции.  

Значение в поле Background соответствует значению, которое будут 
иметь все граничные пикселы в результирующем изображении. Оставьте  
в поле значение, равное 0.  

Input Height (исходная высота) указывает на то, будет ли использо-
ваться при обработке изображения цифровая модель рельефа или фикси-
рованное значение высоты. Оставьте отмеченной опцию DEM и нажмите 
на кнопку Select DEM (выбор DEM). В диалоговом окне выбора результи-
рующего файла укажите файл, содержащий цифровую модель рельефа, 
который создан заранее.  

DEM Resampling (дискретизация цифровой модели рельефа) – это ме-
тод, который будет использоваться для определения значения (интенсив-
ности) пиксела для внутренней расчетной высотной версии изображения, 
которая имеет ту же самую ориентацию и размер пиксела, что и исходное 
изображение IKONOS. Оставьте отмеченную по умолчанию билинейную 
(Bilinear) дискретизацию.  

Geoid Offset (отклонения геоида) – высота геоида относительно сред-
него уровня моря для территории, изображение которой обрабатывается. 
Это постоянная величина, которая прибавляется к каждому значению 
DEM для вычисления разницы между сфероидом среднего уровня моря, 
который используется в большинстве DEM, и поверхностью геоида. RPC-
коэффициенты создаются на основе высот геоида, и эта информация 
необходима для обеспечения точности ортотрансформирования.  

Save Computed DEM (сохранить вычисленную DEM) – параметр 
определяет, будет ли сохранена дискретизированная DEM, которая рас-
считывается в процессе ортотрансформирования. Выберите «No». 

В правой части диалогового окна находятся параметры, связанные со 
степенью и размерами пиксела получаемого изображения. По умолчанию 
значения рассчитываются, исходя из данных геопозиции исходного изобра-
жения IKONOS, которых обычно бывает достаточно. При желании можно 
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изменить проекцию для результирующего ортотрансформированного изоб-
ражения, нажав на кнопку Change Proj... 

 Примечание: если информации о привязке нет в исходном файле, 
ENVI вычислит приблизительные значения, исходя из значений RPC ко-
эффициентов. 

Orthorectified Image Filename (имя файла ортотрансформированного 
изображения) – имя выходного файла. Введите имя IKONOS_ortho.dat. 

После выбора всех параметров нажмите на OK для того, чтобы начать 
процесс ортотрансформирования. 

На экране появится шкала прогресса, отражающая состояние запу-
щенного процесса. Ортотрансформирование может занять несколько ми-
нут, в зависимости от мощности компьютера и размеров обрабатываемого 
изображения.  

Когда процесс завершится, ортотрансформированное изображение 
станет доступно в списке окна AVAILABLE BANDS LIST.  

Проверка результатов ортотрансформирования 

1. Выведите на экран ортотрансформированное изображение в окне 
Display #2. 

2. Сравните исходное изображение IKONOS с ортотрансформирован-
ным изображением, выполнив команду Tools>Link Displays>Link в меню 
окна Display #2. 

3. Щелкните левой кнопкой мыши по одному из окон, чтобы увидеть 
другое изображение. Разница в ориентациях между двумя изображениями 
и есть результат процесса ортотрансформирования. 

Выполните измерение величины смещения точек ортотрансформиро-
ванного изображения относительно соответственных точек исходного 
снимка (выполнить для пяти пикселей из разных частей снимка).  

Использованная для ортотрансформирования ЦМР имеет дефекты, 
которые приводят к искажениям очертаний объектов застроенной терри-
тории на ортотрансформированном снимке. Найдите несколько участков  
с такими искажениями.  
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Требования к отчету 

Отчет должен быть оформлен согласно требованиям СТО СГУГиТ  
и содержать теоретические основы ортотрансформирования снимков  
и краткое описание этапов построения ортофотоплана в программном 
комплексе ENVI с соответствующими скриншотами. Для защиты лабора-
торной работы необходимо ответить на следующие вопросы. 

1. Обратное цифровое ортотрансформирование. 
2. Что такое True Orto? 
3. Смещения, вызванные перепадами высот местности и углом накло-

на космического снимка. 
4. Основные этапы ортотрансформирования космических снимков  

в программном комплексе ENVI. 

5.5. Лабораторная работа № 5  

PanSharpening 

Цель: изучение теоретических основ методов слияния изображений и 
применение изученных методов на практике. 

Задачи: выполнить обработку снимков с использованием методов 
PCA, Brovey, HSV, GrammaShmidt, результаты оформить в виде отчета. 

Используемое программное обеспечение: ENVI. 
Исходные данные: космический снимок IKONOS (в панхроматиче-

ском и спектральных каналах). 

Порядок выполнения работы 

Сначала необходимо открыть панхроматический и мультиспектраль-
ный снимки IKONOS (рис. 45). 
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Рис. 45. Панхроматический и мультиспектральный снимки IKONOS 
 
 

Для слияния отдельных каналов снимка в единый файл программный 
комплекс ENVI имеет инструмент Layer Stacking (рис. 46), расположен-
ный во вкладке Basic tools. Если каналы содержат информацию о привяз-
ке, то она будет использована автоматически, если нет, то необходимо за-
дать систему координат и проекцию вручную. 
 

 

Рис. 46.  Окно Layer Stacking Parameters 
 
 

Для добавления спектральных каналов используется кнопка Import 
file, после нажатия на нее появляется диалоговое окно Layer Stacking Input 
File, в котором необходимо указать спектральные каналы, из которых бу-
дет состоять файл (рис. 47, 48). 
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Рис. 47. Диалоговое окно Layer Stacking Input File 
 
 

 

Рис. 48. Диалоговое окно LayerStacking 
 
 

Файл необходимо сохранить в рабочую директорию. 
Для выполнения слияния изображений применяется функция 

pansharpening программного комплекса ENVI, при этом инструменты для 
выполнения слияния изображений можно запустить из различных участ-
ков меню программного комплекса. Например, Transform>image sharpen-
ing>pansharpening>метод (HSV, Brovey, Gramm Schmidt Spectral Sharpen-
ing, PC Spectral Sharpening, CN Spectral Sharpening) или Spectral>SPEAR 
Tools>Pan Sharpening, или Spectral>метод (Gramm-Schmidt Spectral Sharp-
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ening, PC Spectral Sharpening, CN Spectral Sharpening). Для выполнения 
процедуры pansharpening выберите Transform > image sharpen-
ing>pansharpening>метод (HSV, Brovey, PCA, Gramm Schmidt). Необходи-
мо выполнить слияние изображений с использованием первых четырех 
методов. Первый метод HSV(HSI): после выбора соответствующей вклад-
ки программа предложит выбрать мультиспектральный (рис. 49) и пан-
хроматический (рис. 50) снимки. 
 

 

Рис. 49.  Диалоговое окно выбора мультиспектрального снимка 
 
 

 

Рис. 50.  Выбор панхроматического снимка 
 
 

Затем будет выведено диалоговое окно, в котором вы сможете вы-
брать директорию для сохранения изображения и метод интерполяции 
(рис. 51). 
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Рис. 51.  Диалоговое окно выбора директории 
 

Действия при использовании метода Brovey аналогичны. 
При использовании метода Gram-Schmidt появляется диалоговое ок-

но, позволяющее вносить параметры преобразования (рис. 52). 
 

 

Рис. 52. Диалоговое окно настройки метода Gram-Schmidt 
 
 

Для внесения в файл изображения информации о длинах волн каждо-
го из каналов применяется инструмент Edit ENVI Header>Header Info Ed-
it>Atributes Edit Wavelength (рис. 53). В окно Edit Selected Item впишите 
длину волны соответствующего канала (рис. 54).  
 



70 

 

Рис. 53.  Диалоговое окно ввода параметров снимка 
 
 

 

Рис. 54.  Диалоговое окно ввода длины волны 
 
На рис. 55 показан пример результата применения PanSharpening. 
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а)                                          б)                                         в) 

Рис. 58. Результат PanSharpening:  

а) фрагмент панхроматического снимка  IKONOS (разрешение 1 м); б) 
фрагмент мультиспектральногоснимка  IKONOS (разрешение 4 м); в) фраг-
мент снимка  IKONOS после процедуры PanSharpening (разрешение 1 м) 

 

Требования к отчету 

Отчет должен быть оформлен согласно требованиям СТО СГУГиТ  
и содержать теоретическое описание использованных методов. Основные 
этапы обработки должны быть подробно описаны и проиллюстрированы 
соответствующими скриншотами. По результатам лабораторной работы 
должны быть сделаны выводы об эффективности использованных алго-
ритмов. Необходимо проанализировать результаты обработки, создать ре-
гион интереса во вьювере с мультиспектральным снимком, вывести стати-
стику распределения яркости в спектральных каналах для каждого резуль-
тата Pansharpening и сравнить с соответствующими показателями исход-
ного изображения. 
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ЗАКЛЮЧЕНИЕ 

В учебно-методическом пособии представлены некоторые алгоритмы 
цифровой фотограмметрии, которые реализованы в современных про-
граммных продуктах для обработки данных дистанционного зондирова-
ния. Часть рассматриваемых методов опирается и дополняет материал, 
изученный в предыдущих семестрах в рамках курсов «Фотограмметрия  
и дистанционное зондирование» и «Современные методы и средства фо-
тограмметрии и дистанционного зондирования». Методические указания  
к выполнению лабораторных работ, представленные в практической части 
учебно-методического пособия, предоставляют возможность закрепить на 
практике знания, полученные обучающимися при освоении теоретическо-
го курса.  

Учебно-методическое пособие призвано: 

 вырабатывать умение систематизировать и обобщать усвоенный 
материал; 

 способствовать закреплению знаний, полученных обучающимися 
на лекциях и во время самостоятельной подготовки; 

 служить основой для самоконтроля знаний при изучении дисципли-
ны «Цифровая фотограмметрия». 
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Приложение 1 

СОДЕРЖАНИЕ ФАЙЛА RPC 

 

satId = "QB02"; 
bandId = "P"; 
SpecId = "RPC00B"; 
BEGIN_GROUP = IMAGE 
 errBias =   19.94; 
 errRand =    0.16; 
 lineOffset = 4196; 
 sampOffset = 4204; 
 latOffset =   54.8344; 
 longOffset =   83.0995; 
 heightOffset = 113; 
 lineScale = 4218; 
 sampScale = 4393; 
 latScale =    0.0234; 
 longScale =    0.0404; 
 heightScale = 500; 
 lineNumCoef = ( 
   +2.761271E-03, 
   -3.072224E-02, 
   -1.028630E+00, 
   +4.165263E-03, 
   -5.359907E-05, 
   -8.715256E-05, 
   +3.678947E-04, 
   -2.958128E-04, 
   -1.419593E-03, 
   -4.110511E-06, 
   +1.132993E-06, 
   +1.017891E-06, 
   -7.839431E-08, 
   -1.589864E-07, 
   -1.655401E-06, 
   -2.160949E-06, 
   +4.962138E-07, 
   -8.687981E-06, 
   +7.339841E-07, 
   +1.142071E-06); 
 lineDenCoef = ( 
   +1.000000E+00, 
   +2.111245E-05, 
   +1.376572E-03, 
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Продолжение приложения 1 
 

   +3.634040E-04, 
   -4.821888E-08, 
   +6.885399E-07, 
   +1.333438E-06, 
   -9.263498E-07, 
   +1.698099E-06, 
   +1.131046E-06, 
   +2.103686E-07, 
   -2.370590E-06, 
   -1.416335E-07, 
   +6.269583E-07, 
   +1.950562E-06, 
   +1.546882E-06, 
   -1.521145E-06, 
   +4.252932E-06, 
   +1.013198E-06, 
   -2.144031E-06); 
 sampNumCoef = ( 
   -2.406202E-03, 
   +9.842813E-01, 
   -2.959988E-02, 
   +4.336420E-02, 
   -3.327386E-04, 
   +6.707702E-04, 
   -4.781496E-04, 
   +1.162012E-03, 
   -1.220072E-05, 
   +2.598437E-05, 
   -1.117064E-06, 
   +1.135672E-06, 
   -2.459909E-07, 
   +1.691040E-07, 
   -3.917887E-07, 
   +6.511295E-08, 
   -3.828799E-07, 
   +2.526496E-06, 
   -2.905275E-07, 
   -2.831164E-07); 
 sampDenCoef = ( 
   +1.000000E+00, 
   +1.185508E-03, 
   +2.767442E-04, 
   -5.767579E-04, 
   -2.141217E-07, 
   -1.144067E-06, 
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Окончание приложения 1 
 

   +8.753136E-08, 
   +1.385107E-06, 
   -1.355571E-08, 
   -4.773501E-07, 
   +3.010492E-08, 
   -9.962255E-07, 
   +4.585584E-07, 
   +5.532211E-08, 
   -3.716872E-07, 
   +1.904359E-08, 
   +1.035698E-07, 
   +1.793737E-05, 
   +3.178056E-08, 
   +7.547142E-08); 
END_GROUP = IMAGE 
END; 
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Приложение 2 

СОДЕРЖАНИЕ ФАЙЛА TIL 

 
bandId = "P"; 
numTiles = 1; 
tileSizeX = 8400; 
tileSizeY = 8400; 
tileUnits = "Pixels"; 
tileOverlap = 0; 
BEGIN_GROUP = TILE_1 
 filename = "08OCT22055850-P2AS-052122175010_01_P001.TIF"; 
 ULColOffset = 0; 
 ULRowOffset = 0; 
 URColOffset = 8399; 
 URRowOffset = 0; 
 LRColOffset = 8399; 
 LRRowOffset = 8399; 
 LLColOffset = 0; 
 LLRowOffset = 8399; 
 ULLon = 83.06150994; 
 ULLat = 54.85774377; 
 URLon = 83.13995769; 
 URLat = 54.85638629; 
 LRLon = 83.13756415; 
 LRLat = 54.81113045; 
 LLLon = 83.05920399; 
 LLLat = 54.81248566; 
 ULX = 632328.30002688; 
 ULY = 6080908.49999885; 
 URX = 637367.70003490; 
 URY = 6080908.49999878; 
 LRX = 637367.70003464; 
 LRY = 6075869.09999878; 
 LLX = 632328.30002667; 
 LLY = 6075869.09999886; 
END_GROUP = TILE_1 
END; 
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Приложение 3 

ОЦЕНКА ТОЧНОСТИ 

 

Таблица П.3.1  

Оценка точности 

№ 

точки 

SPOT Landsat 
∆x ∆y ∆x2 ∆y2 mx my 

x y x y 

           

 

 

Таблица П.3.2  

Сводная таблица оценки точности результатов трансформирования 

кол-во опорных точек метод трансформирования mх mу 

18 polynomial 3   

18 polynomial 2   

9 polynomial 2   

18 polynomial 1   

6 polynomial 1   

18 RST   

4 RST   

18 Triangulation   

6 Triangulation   
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